Milling Machine Tutorial

Use the Accurate CNC 427 to mill printed circuit board prototypes

Kirsch Mackey
UNIVERSITY OF ARKANSAS 800 W Dickson Street, Fayetteville, AR, 72701
Milling Machine Tutorial

Contents
1. Overview of the Printed Circuit Board (PCB) Process..................................................2
   1.1. Phase 1 – Design and Create the PCB Layout.......................................................2
   1.2. Phase 2 – Transfer the Layout Design to Software..................................................2
   1.3. Phase 3 – Etch the PCB with the Milling Machine..................................................2
   Summary and Scope of this Tutorial/Training....................................................................2
2. Materials and Environment............................................................................................3
   2.1. Overview..................................................................................................................3
   2.2. Milling Machine Policy............................................................................................3
   2.3. Milling Machines.....................................................................................................3
   2.4. Artwork/Gerber Files..............................................................................................4
   2.5. Machining Tools.....................................................................................................4
   2.6. Vacuum Table and Pump.........................................................................................5
3. Training on the Machine – Top Side..............................................................................6
   3.1. Initial Setup..............................................................................................................6
   3.2. Importing your Design............................................................................................6
   3.3. CNC Mode..............................................................................................................12
   3.4. Mill the top of the board.........................................................................................16
4. Training on the Machine – Bottom Side.......................................................................19
   4.1. Mill the bottom of the board.................................................................................21
5. Frequently Asked Questions and Problems..................................................................22
6. Tips and Tricks...............................................................................................................23
1. Overview of the Printed Circuit Board (PCB) Process

Before we get into how to use the Accurate CNC 427, we will cover the PCB flow process. In this tutorial, you will learn how to use the Accurate CNC 427 milling machine to create a printed circuit board from bare copper clad material.

1.1. Phase 1 – Design and Create the PCB Layout

The engineer would use any design software to lay out the printed circuit board design. Popular software examples for this are OrCAD Layout, Allegro PCB Editor, Eagle CAD, KiCAD, and so on. This tutorial and training assumes you made your PCB layout files in Allegro PCB Editor. Once you’ve laid out your PCB design, you would create artwork files (also known as Gerber files) and drill files. These files are used by the milling machine to understand your board design.

1.2. Phase 2 – Transfer the Layout Design to Software

Once your artwork files are ready, you import them into the software that controls the milling machine – PhCNC64. There are various tools and settings to be made based on the board you’ve designed. It is important for the designer to know the capabilities of the machine (e.g. minimum pin pitch, insulation width, etc.) when designing his/her board layout. Once the artwork files are imported and interpreted by the milling machine, the designer can etch out the PCB.

1.3. Phase 3 – Etch the PCB with the Milling Machine

The designer must understand some of the tools and machining process to ensure the proper conditions for milling a PCB out of bare copper clad. The milling machine etches away the copper as instructed by the artwork files and results in a nicely made single- or double-sided PCB.

Summary and Scope of this Tutorial/Training

This training and Tutorial will only focus on phases 2 through 3 of the above 3-phase process.
2. Materials and Environment

2.1. Overview

In this chapter, you will learn about the machine use policy, milling machine function and capabilities, what artwork files the machine uses, the tools and their capabilities and the machine vacuum setup. It is important to understand how these materials work and need to be used in training.

2.2. Milling Machine Policy

The materials in the lab are quite expensive, so it is imperative that the designer does not adjust any settings or devices outside of what is instructed in the tutorial. Also, other designers using the machine depend on the machine settings remaining exactly the same. Here are the main rules:

1. **Do not change any settings or tools in the milling machine.** If any settings or tools are discovered to have been changed, the person responsible will have machine use privileges revoked, then will need to go through training again to use the machine. If you need special tools or settings for your design, speak with the Electrical Engineering Design course GTA or contact eleghelp at eleghelp@uark.edu.

2. **You may only use the milling machine during normal business hours** (9 am – 5 pm Monday through Friday) without supervision.

3. **Only students in Electrical Engineering Design 2 may use the copper clad.** The copper clad is paid for using the course funds. Any non-EE Design student must use his/her own copper clad for milling or training purposes.

4. **You must schedule your appointment at least 3 business days ahead of time to use the machine.** The department’s EE Design students may have leniency on this rule, depending on the situation, because they always have priority on use of the machine.

2.3. Milling Machines

Milling machines are devices that use rotary cutters to remove some sort of material from a surface. In our case, we would be removing copper from a single-layer or double-layer piece of copper clad. After the copper is removed and etched away, the milling machine produces a beautiful circuit board, ready to be soldered to. The simple process is shown in Figure 1 below.
Figure 1. Bare Copper Clad Through Milling Machine to PCB
*images from left to right: (1) Veys.com Homemade PCBs (2) Accurate CNC (3) Pyroelexco*

2.4. Artwork/Gerber Files

The milling machine uses artwork/Gerber files to know how to cut out a printed circuit board. There are various layers to a PCB board so there are various types of artwork/Gerber files used in the manufacturing process. However, the Accurate CNC 427 machine may only make use of these type of artwork files found in **Table 1**.

<table>
<thead>
<tr>
<th>File name and extension</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top.art</td>
<td>Top side of copper clad (routing and traces)</td>
</tr>
<tr>
<td>Stencil_top.art</td>
<td>Top side solder paste stencil</td>
</tr>
<tr>
<td>Outline.art</td>
<td>The cut-out shape of your finished board</td>
</tr>
<tr>
<td>Bottom.art</td>
<td>Bottom side of copper clad</td>
</tr>
<tr>
<td>Designname.drl</td>
<td>Drill hole information</td>
</tr>
</tbody>
</table>

Some software does not produce an outline file. If you want your PCB dimensions cut out exactly from a copper clad panel, then you need to generate the appropriate outline artwork file. Otherwise, you will have to deal with your design being on a larger panel. Some designers use copper clad that matches exactly with their design dimensions, so all these choices are based on personal preference.

2.5. Machining Tools

There are 4 types of tools used in the milling machine. The uses and differences between the tools are shown in **Table 2**.

<table>
<thead>
<tr>
<th>Tool Type (Tool Bit)</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>V-tip (link)</td>
<td>Etches out insulation paths by cutting away copper. Fine copper rubout</td>
</tr>
<tr>
<td>Stub-end (link)</td>
<td>Used to rub away excess copper. Isolates copper traces completely.</td>
</tr>
<tr>
<td>Drill (link)</td>
<td>Only drills holes exactly the diameter of the tool. No larger and no less.</td>
</tr>
<tr>
<td>Router (link)</td>
<td>Drills holes equal to and greater than its diameter. Also for cutting</td>
</tr>
</tbody>
</table>

*Note: internet link to the tools used by the machine*
Knowing the above tools and how to use them is very important for milling out proper boards. The Accurate CNC 427 milling machine holds up to 12 tools and the department may change them over time. Below is a link to the most up-to-date tool list for the machine, so design your board specs accordingly if you want to use this milling machine for future boards.

2.6. Vacuum Table and Pump

The Accurate CNC 427 Milling Machine has a vacuum table to place the copper on for milling and is shown in Figure 2. Normally it cannot be seen because we place a porous cardboard-like material over it, then the copper clad rests on top of that cardboard-like material. The vacuum table is connected to the vacuum pump illustrated in Figure 3. Turning on the vacuum pump will create negative pressure on the platform. The pressure forces the copper clad toward the bottom of the table and therefore holds it in place. This mechanical set up keeps the copper clad in place while the machine etches away its traces.

![Figure 2. Accurate CNC 427 and Vacuum Table](image1.png)

Now that you’re familiar with artwork/Gerber files, the tools, and the Accurate CNC 427 machine setup, you have enough information to create your first board.
3. Training on the Machine – Top Side

Here are the steps to be trained on the milling machine and the bolded items are what we cover in this chapter:

1. Log into the milling machine computer with someone from eleghelp
2. Open PhCNC64 software and import example PCB artwork files
3. Set up the tools in the CAM mode of the PhCNC64
4. Go to CNC mode of PhCNC64 and set up the machine for initial run
5. Fix some copper clad onto the machine for milling
6. Use PhCNC64 to mill the top of the design on the copper clad
7. Flip the copper clad, re-align it using the PhCNC64 software and camera
8. Use PhCNC64 to mill the bottom of the design on the copper clad
9. Remove the finished board, vacuum clean the area, then log out and leave
10. Sign the milling machine certification form and turn it into the eleghelp office

Once you are done with the above process, you’ve completed your training on the milling machine. Eleghelp will then enter your information into their system so that you can use the PhCNC64 Pro software any time Monday-Friday 9 am – 5 pm. However, remember that you must schedule your appointment at least 3 business days ahead of time to use the machine.

For a video of how the process works, go here. The video uses a different demo board, so not all the tools are the same, but you should get the idea of how one should vary the tools to suit the board being made.

3.1. Initial Setup

To do training on the milling machine, you would log into the computer next to the milling machine. Open the PhCNC64 Software from the Desktop or Start Menu and have the Senior Design Graduate Teaching Assistant (GTA), or eleghelp (across the hall of ENGR 115) type their information in the software for you. Until you’re approved for training, you won’t be able to log into the software without someone entering their credentials.

The Senior Design GTA/eleghelp will leave, then you will continue through this tutorial to mill out your first board on your own. The process will be relatively hands-off for the trainer/instructor.

3.2. Importing your Design
Overview: Once you’re given access to the PhCNC64 software, you import the artwork files from the local computer into PhCNC64. Then you import the files as a PCB design into the CAM mode of the software. In CAM mode, this is where you pre-select all the tools that will be used to mill out your board. You then process the rubout and verify that your board looks the way you intended it.

Now here’s a more detailed look at the process described just above.

Step 1 – Locate and Import Artwork Files

First we’re going to find the files in the installation folder of the Demo version of PhCNC. So in the software, click menu File Import Gerber & Drill. Navigate to “C:\Program Files\PhCNC64 Demo\SAMPLES\PID”. Now that we’re in the folder, we are looking at the artwork files discussed earlier. They describe the board, so we need to import them properly. Click once on the PID__Bottom_Copper.TXT. I will show up on the right window section, so check mark the box that says Bottom. Then select PID__Mechanical.TXT, check the “Mech” field on the right for that file. Click the PID__Top_Copper.TXT file then check mark Top.

Important Note: for your own designs, you’ll likely have an OUTLINE.art file. Choose “Mech” for this type of file. It serves the same function as the Mechanical.TXT for our example board.

Basically you’re matching the layer type on the right with the file that you chose on the left so your window should look like below.

![Figure 4. Gerber Files Setup](image)

Gerber files setup

Lastly, click the Drill file → click the “Top” box on the right and a window will pop up. The settings here need to match the Excellon/Gerber file format settings in your layout software. This can be metric units, Imperial units or any kind of zero spacing. You will need to double-check your Excellon settings to make sure you choose the correct options for your design.
Figure 5. Drill File Setup

**Tip:** If you’re not sure of your settings, you can do this instead: Click “Auto detect” button → OK.

If the design on the black background looks just like your original design in your layout software, click in the upper right and your board will look like below (our view is zoomed in close).

Step 2 – Set Up the Tools for Insulation and Rubout

One can see in Figure 6 that we are in CAM mode. CAM mode is necessary to view all the different types of artwork files generated by PCB Layout software. Earlier, we mentioned that the machine has specific tools that need to be set up so we will do those now.

**Insulate**

1. Click **Insulate** button → **Select Tool ATC**.
2. Click “V” 45° → **Select**.
3. Set Diameter [in] = whatever your smallest pitch is, but go with 0.007 for this tutorial.
4. Set Tool Tip [mil] = 5.0, because that is the width of the extreme tip of the V-45 too.
5. Notice that the software will automatically calculate the depth of the V-45 tool.
6. Check **Remove spikes (IPD)** → click **OK**.

Usually the V-45 is good enough for insulation cut-outs that are even as small as 5.3 mils between traces.
Note: The 5.3 mils is the smallest space the V-45 tool can cut, so if you’re milling with this machine for a custom board, ensure that your space between traces is no smaller than 5.3 mils.

**Cut**

This setting selects the tool that will cut your board out at the end of the entire milling process.

1. Click ![Cut button](image1) → Select Tool ATC.
2. Click 0.063 (1.6mm) →
3. Set Penetration Depth [mil] to 69.0 → OK.

**Rubout**

You will now select the tools to etch away extra copper from beside your traces. Rubout is technically unnecessary, but it helps to ensure solder doesn’t spill over from a trace to a copper plane so easily while you’re soldering parts to the finished PCB.

Unfortunately, Rubout also usually doubles or even triples the time to mill out a board. Luckily we can get the benefit of Rubout without as much time lost if we choose Insulation Rubout instead of Full Rubout. This is because Insulation rubout only removes copper up to a certain distance away from the traces, not the entire board. This will save us a lot of time.

1. Click ![rubout tools](image2) → Select your tools in the same way you chose Insulate tools, but use the following tools and depths instead:
   a. In the first tool slot, choose the “V” 45° tool. Its setting depends on the smallest insulating valley/groove you have, so set the Diameter accordingly (typically 0.007 in), then set the tool tip to 5.0 mil. The computer will calculate the appropriate Penetration Depth.
   b. In the second tool slot, click Select Tool ATC and choose something like the 0.0313” Stub End Mill. The computer will set Penetration Depth to whatever it calculates for that tool, because the insulation width is the same as the tool diameter. The tip of the tool is also the same as the diameter, so notice that the ‘Tip’ field gets faded out and cannot be changed. Notice that the penetration depth is chosen to be anywhere 3 mil – 5 mil.
   c. Fill in tools for each subsequent tool slot as you like, depending on how much rubout you need done. Using larger diameter rubout tools will save you a lot of time if you require more copper to be rubbed out. Make sure those tools you want to use are check marked.
2. Once you’re done selecting tools for the job, make sure rubout settings near the bottom of this Rubout Tools window are:
   a. Rubout type = Insulation Rubout (Insulation Rubout takes less time than full Rubout).
   b. Rubout direction: X-Serpentine
   c. Insulation rubout width: 0.050 in. Increase this rubout width setting if you want more copper rubbed away from outside your traces.
3. For this tutorial, the V-45, Stub End Mill 0.0313 and 0.0625 tools were chosen.
4. Verify your settings are what you want, then click ![OK](image3).

**Step 3 – Set Up the Tools for Drill**
The board has many holes of different sizes, but only so many router and drill bits to make them. You will select the drill/router bits closest to the hole sizes in the board. Recall that while drill bits only make holes exactly their own size, router bits can make holes their own size or larger.

1. In PhCNC window, click Drill button.
2. Click on the first hole (0.0300) → click. 
3. Click the 0.0315 Router Bit → click → Yes. The software will ask if this is okay, so click Yes. The reasoning is because it's better to have a slightly larger hole than a hole that is too small for a part to fit through.
4. Click the 2nd hole (0.0400) → click. Click the (0.0315) Router Bit → click .
5. Likewise, choose the (0.0315) Router Bit for the (0.0450) hole.
6. For this (0.0600) hole, you might consider the 0.0315 Router Bit, but there is a potential problem. The router bit will mill the larger hole, but it’s almost twice the diameter of the bit. From our experience, what will happen is the router bit will bend more as it creates this large hole. The bending will create an uneven hole with a concave cross-section. In this situation, it's best to look for a router/drill bit that's closer to the diameter of this 0.060" hole. Luckily we have a 0.063" Router Bit, so choose that instead.
7. Click the last hole (0.1250) → click . We must choose the (0.063) Router Bit because there is no wider cutting/routing tool. Click 0.0630 → click .
8. Verify that your settings are similar to the image below then close the window.

![Figure 7. Correct Drill Settings for PID PCB](image)

All the tools should be okay when you look at the Project Tools button at the top of the CAM mode window.

**Step 4 – Process the Rubout**
Rubout is simply removing any copper that doesn't belong on the board or that is not a trace. It can make the difference between a shoddy board and a beautiful one. It also reduces the likelihood of solder spilling onto a copper plane and shorting out some of your traces.

**How to process rubout**

1. Click the button once (near top of the CAM mode window shown in Figure 8).
2. Click and drag within the board design to create the areas where you'd like to rub out copper.
3. Click the button once to execute rubout. You'll know you've done it correctly when your board has added some green color on the design.

   ![Figure 8. Rubout Buttons Location](image)

4. Click the button in the upper right of the CAM mode window (see Figure 9).
5. Choose and/or to see the copper views seen in Figure 9 and Figure 10. The board is shown in with green areas indicating the removed copper areas.

   ![Figure 9. Copper Top View with Rubout](image)
Once your board is similar to above you’re ready to control the machine in CNC mode.

3.3. CNC Mode

**Overview:** Now that you’ve selected the right tools, you will use CNC Mode to give you control of the machine. Then you will grab some copper clad and place it on the center of the milling machine vacuum table. Next, you will help the machine calibrate its X, Y and Z coordinates, align the design with the copper. Finally, you will double check to make sure the tools are ready for use and in the correct locations, then set the machine to run and mill the top of your board.

Below is the above process in detail.

**Step 1 – Align the machine axes in CNC Mode**

As mentioned earlier, you will go into CNC mode. You’re in CAM mode, still but follow the instructions below.

1. Click on the CNC button on the toolbar near the top of the window.
2. Now that you’re in CNC mode, the machine will be in Emergency Stop mode. Depress (click) the Emergency Stop button . The software will ask to Home the machine, click **Yes**.
3. Wait until the machine is done homing the X and Y coordinates of the machine (you may also click the Home XY button at the far left of the software to home the machine).

Now that the machine is homed, click the Park button on the left software pane. This will place the spindle out of the way so you can place and align the copper.

**Step 2 – Place the board**

To place the copper, you’ll choose a 3” x 4” piece of copper clad from the stack to the left of this computer (red drawer). The copper material should be smooth or at least uniform. So, use the tough brown wool like material found on the machine work desk to buff the copper clad like using sandpaper on wood. This evens out the copper nicely.

Place the copper clad on the center of the vacuum table platform. Then, bring the copper clad a bit closer to yourself, while making sure it’s a few inches away from the edge facing you. Turn on
the vacuum pump and fan, making sure the pressure gauge reads about -79 to -81 as illustrated in the images of Figure 11.

![Figure 11. Vacuum Pump Switch, Pressure Gauge, Vacuum Pump and Fan, Control Knob](image)

The pressure will force the copper clad to adhere to the table so it stays in place during milling. Try to slide it away with your fingers and see if it budges. If it moves easily, you’ll have to tape it to the cardboard-like material along all 4 edges of the copper clad.

The machine does not know where the copper clad actually is. Therefore, you must place the design layout file (virtual board) in the location where the copper clad (physical board) was placed on the real-life machine platform. In order to do this, we must learn how to control the machine spindle.

**Spindle Navigation and Control**

Use the arrow buttons in the CNC mode window and the different step size buttons shown in Figure 12 to advance the spindle ( ) anywhere from 0.001 to 1.0 inches at a time. Holding down a button for 1 second will make the machine move continuously in that direction.

**Important Note**: Do not click the Z+ or Z- buttons. They rarely need to be clicked.

1. Click the X+, X-, Y+ and Y- buttons until you get the spindle about the center of the copper that you placed on the board earlier.

Pay attention to the physical copper board to do this center alignment, not the virtual board on the software. The software/machine doesn’t know where the copper actually is, but you do.
Once the spindle is in the center of the copper, click Home Z button. The machine will touch the copper surface with its Pressure Foot, compare it to a pre-known surface height relative to the machine itself, then calculate how far the copper surface is along the machine’s Z axis. Now that the machine has its bearings, we must ensure it mills the virtual board in the correct location.

**Step 3 – Align the board with the Camera**

You’re going to use the camera on the machine (attached diagonally to the left of the spindle) head to align the virtual board with the physical board. To do this, click the “Chase Camera” button above the button. A window will show up with video that is very out of focus.

There will also be a light shining brightest where the camera is located. Note again that the camera is not in the same location as the spindle. This differentiation is important because we use the camera to get to the center of the copper in the next few steps and.
Firstly, move the camera window that popped up (as is Figure 13) out of the way so you can see the software CNC mode. Next, use the arrow/navigation keys to place the camera (not the Spindle) in the center of the physical copper board. The light should be shining brightest around the center of the copper clad now.

Next, look at the video pop-up window that you moved out the way earlier. In the lower left corner, click the **Auto Focus** button. The machine camera will focus on finding the copper surface and bring it into clear view. This may take up to 30 seconds. You’ll know when it’s done when the Z-axis coordinates stop moving. The machine will ignore all commands (except Emergency Stop) until it’s done with **Auto Focus**.

![Auto focus](image)

*Figure 14. Camera Crosshairs on Copper Corner*

Now that the physical board is in clear view, you’ll want to move the camera view to the upper right corner of your physical board, just like in Figure 14. Then in PhCNC64 work area (black area), right click, then choose “Add Thumbtack (Camera Position)”. Notice that a yellow crosshair will show up to mark the corner the camera crosshairs are looking at. Repeat this alignment with the lower left corner of the physical board and your PhCNC64 window might look like Figure 15.
Moving the Virtual Board

Now that you know the extremities of your physical copper clad on the platform, you can move the virtual board into that region. Click the CNC button to go into CAM mode. Right click the work area, choose Select/Clone/Move Objects from the dropdown, then click and drag your virtual PCB comfortable between the thumbtacks you made. Now you know that the design will be milled in the proper location, because you just aligned it based on the corners of the physical copper clad. Go back into CNC mode by clicking the CNC button. Now that the board is aligned, we are ready to check the tools.

Step 4 – Check the tools

Next we will check to see if the tool settings are correct.

1. Back In CNC mode, click the ATC Control Panel button. The machine may ask if you want to check the tool holders and spindle. Choose “Yes”. The machine will first check to see if it has a tool in its spindle collet, then check the rest of the tools in the tool magazine.

2. When that is done, you’ll want to look at the top section of the now-open ATC Control Panel window. It shows all the tools that are in the machine. In the section below, it shows all tools that are actually used in the project.

3. Be sure to change all the Drill and Cut tool depths from 80 mils to 69 mils.

3.4. Mill the top of the board

Now that the boards are aligned and the tools are correct, we will set the project in motion.
1. Click the drop-down arrow in the upper-right area of the software (see Figure 16).

2. Select “Entire (Top)** and ensure that all 3 options in the white window below are check marked (1. Insulation (Top), 2 Rubout (Top), 3 Drill (Top)).

3. Once that is correct, click the “RUN (GO)” button.

![Figure 16. Project Step List and Spindle Warmup Windows](image)

Immediately after this, close the lid of the enclosure. This is to avoid injury/death in case something goes wrong with the machine operating at high revolutions per minute. The machine will warm up for 120 seconds to maintain the spindle life of the tool. At this point, you can sit back and watch the machine mill out the board.

**Step 1 – Wait for the top to mill**

The machine will rev up to about 60,000 – 80,000 RPM during operation. When it finishes each major step (Insulation, Rubout, Drill), it will show a green check mark on the list from to show that it has finished each step. Watch the board to see if there is any strange behavior from the machine or if the machine suddenly goes into Emergency Stop Mode. If strange activity is going on with the machine, contact eleghelp@uark.edu or walk across the hall and knock on the eleghelp door.

**Step 2 – Inspect and buff the board**

When the milling process is completed, there will be burrs on the copper clad. Burrs occur during any milling process, so use the tough brown sandpaper-like material to buff the copper thoroughly and make it smooth again. Be sure to buff both sides of the board well.

The top of the copper is milled and buffed, so turn off the vacuum pump, flip the board about the axis pointing away from you, then place it back down on the platform, just like in below.
Figure 17. Flip the Board About the Red Line
4. Training on the Machine – Bottom Side

Here are the steps to be trained on the milling machine and the bolded items are what we cover in this chapter:

1. Log into the milling machine computer with someone from eleghelp
2. Open PhCNC64 software and import example PCB artwork files
3. Set up the tools in the CAM mode of the PhCNC64
4. Go to CNC mode of PhCNC64 and set up the machine for initial run
5. Fix some copper clad onto the machine for milling
6. Use PhCNC64 to mill the top of the design on the copper clad
7. **Flip the copper clad, re-align it using the PhCNC64 software and camera**
8. Use PhCNC64 to mill the bottom of the design on the copper clad
9. Remove the finished board, vacuum clean the area, then log out and leave
10. Sign the milling machine certification form and turn it into the eleghelp office

**Step 1 – Setting up the bottom side**

1. Place your copper back in the cavity, tape it down again, then turn on the vacuum pump making sure the pressure is between -78 and -80 (use the knob as necessary). Even with the vacuum up, the suction may not be enough to hold the board. In this case, you must tape the edges of the copper clad to the platform. Try to cover as little copper as reasonable to still hold down the copper, though.
2. In PhCNC64, click **Program** → Entire Bottom to flip the design, too.
3. Click the Spindle Path button, in the upper right area to remove the red lines (see Figure 18).

   ![Figure 18. Remove Spindle's Path Data History](image)

**Video mode and Fiducial Registration**

1. Right click the work area and select “Video Mode”.
2. Use the navigation buttons to move the camera head to the center of the copper clad.
3. Right click the area again → click “Fiducial Registration”.
Fiducial registration shows all the holes on the board. Since the machine never knows where the copper clad is and we moved the copper by flipping it, we have to re-align the boards again. This time, we'll use the camera to do it automatically.

**Step 2 – Automatic hole alignment**

*Finding the first hole*

1. Place the center of the hole finder tool (HFT) on a hole. The HFT is in Figure 19 (far left).
2. Click the “Auto focus” button on the video window.
3. Move the machine following the arrows on camera until you reach the hole marked by the HFT center in the camera view. At this point since you've found the center of the hole, remove the HFT.
4. Right click the black work area → Auto Hole Detector.
5. Right click the work area again → Move to hole center. If the area is in poor condition (not buffed well enough), the camera may mistake certain sections as holes, so be sure you buffed the board well enough.
6. At this point, find the hole on your virtual board that matches with the physical copper hole you just found using the camera.
7. Use the mouse to Zoom all the way to the center of that virtual hole in software.
8. Right click in the exact virtual hole center → **Move to Hole Center (Fiducial Point 1)**. Notice the entire virtual board design has shifted.
9. Right click the work area → Auto Fiducial Registration (AFR) → Assisted AFR.
10. Follow the virtual PCB to find different holes, making sure that the camera picks up the measurements of the physical holes on the copper clad. The goal here is to expose as many physical/actual holes to the camera as possible.
11. When enough physical holes are exposed to the camera crosshairs, the software will eventually prompt you. Expose enough holes to the camera (8 or more) → Software asks to execute Fine Auto Fiducial Registration → **Yes**.
12. Let the software finish align the board automatically.

Even if alignment doesn't reach above 50% when it's done, the board is usually aligned well enough for milling. Double check the board by seeing if the camera view of the traces and holes on the physical copper are aligned with the virtual PCB traces and holes.

*Figure 19. Hole Alignment Using the Hole Finder Tool (HFT) (a) Hole Finder Tool, (b) HFT Arrows, (c) Hole Center Alignment, (d) Hole Quality Estimation*
4.1. Mill the bottom of the board

Now that the board is aligned, it is ready to be milled.

1. Right click the work area → uncheck Video Mode.

2. Click the Home XY button.

3. Place the center of the spindle at the center of the copper clad → Home Z.

4. Ensure that Program is set to “Entire Bottom*”.

5. Click the Run (GO) button.

6. Watch the machine mill the second side of the board.

Cleanup

1. You’ll know when the job is finished when all steps of the program have green check marks next to them and when the spindle has come to complete rest.

2. Click Park button (left of CNC window) to move the spindle out of the way.

3. Then click the Emergency Stop button.

4. Turn off the grey vacuum pump and the fan.

5. Remove the stencil (if you’re using one) and your cut out copper clad.

6. Examine your board and put the extra copper and stencil away.

7. Turn on the black vacuum cleaner found below the milling machine desk.

8. Vacuum out the milling machine platform and spindle very well.

9. Close the milling machine enclosure lid.

10. Close PhCNC64 software → Save project in Documents or anywhere else you’d like.

11. Log out the computer → notify the trainer you finished and turn in the certification form.
5. Frequently Asked Questions and Problems

Q1: May I use my own PCB design to do milling machine training?

No, you may not use your own PCB design to be trained on the milling machine.

P1: The rubout still has pieces of copper left on it.

S1: The rubout tool may be damaged, has too shallow a depth (a good depth ranges from 6 – 8.1 mils), or the wrong tool is placed in that tool holder. Email eleghelp@uark.edu.

P2: The machine camera disconnects when I’m using it.

S2: This may happen if you move the machine too fast/long while the camera is on. Turn off video mode first, then move the camera over the large distances OR only move in steps (as large as 1.0 steps is fine).

P3: Pressure won't get up to -75.

S3: Maintenance required. Email eleghelp@uark.edu.

P4: The holes are not aligned.

S4: You’ll need to re-align manually. Please see the PhCNC User’s Manual > Section 6. Fiducial Registration > 6.3.

P5: I need to fix only one area or add a hole, but don’t want to re-do the entire board.

S5: You can select a machining window. In CNC mode, right click the top left area of where you want the machine to work/mill → Select Machining Window → Left click the lower right corner of the area you want to mill → Choose the appropriate program to run. Only one machining window can be implemented at a time, so repeat this process as many times as needed.
6. Tips and Tricks

**Tip 1: Place extra holes in your design.**

In Project Mode, simply right click where you want the center of the hole to be → Insert → Custom Hole….

*See PhCNC User’s Manual > Section 2.18 Holes and pads insertion (Pro version only).*

**Tip 2: Measure distance.**

Do this by holding down the space bar and moving your mouse to the desired spot.

**Tip 3: Add text to board.**

Place text anywhere on your board. In Project Mode right click where you want to place text → Insert → Vector Text → Type in text and adjust the font → OK → Right click work area → Select/Clone/Move Objects → drag text anywhere.

*See PhCNC User’s Manual > Section 2.19 Vector Text Insertion function (Pro version only).*

**Tip 4: Mill multiple copies of the same board.**

In Project Mode, right click the work area → Select/Clone/Move Objects → click on the board design → right click → Clone (Copy) objects → Move the new board.

*See PhCNC User’s Manual > Section 2.8*

**Tip 5: Group/ungroup objects.**

*See PhCNC User’s Manual > Section 2.9*